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Introduc tion
When the first version of this book was born just over four years ago, my hope 
was for it to be one book in a long and successful series that would educate, inspire, 
and even excite many people about using the Autodesk® AutoCAD® Civil 3D® soft-
ware. In order to make that happen, I decided that each book in the series had to 
meet the following criteria:

▶▶ It should be basic enough to enable anyone to learn Civil 3D.

▶▶ It should be in-depth enough to enable a person to be productive 
using Civil 3D for basic tasks.

▶▶ It should foster understanding by associating the things you do in 
Civil 3D with familiar things you see every day.

▶▶ The examples and exercises should be based on the real world.

▶▶ The book should not simply demonstrate random software features 
but should also teach the process of project completion using Civil 3D.

Since the first version of the book was released, I have received tons of great 
feedback about how well this book functions in many learning environments. I 
have also used the book myself to teach classes in a corporate environment, and 
I am very pleased with how it performs. I am confident that the goals I listed 
have been met, and for that reason I have held to the same writing style, format, 
and delivery that proved to be so successful in the previous versions.

As you work your way through the book as a teacher, a student, or an end 
user, you’ll find that the first two chapters, although very important, are more 
general and introductory. After that, you’re going to take a journey through the 
completion of a residential land development project—start to finish. In fact, the 
example project is based on a residential development that was built about 10 
years ago, not far from my home. The topics are presented as though you have 
never touched a CAD program before, and wherever possible, there are sidebars 
and other forms of augmentation that relate what you’re doing to the real world.

You’ll also find that as I wrote this book, I tried to sympathize with future 
readers by thinking back to my college days when I was learning about survey-
ing and civil engineering for the first time. There were many times when I felt 
frustrated and lost because I was learning new and foreign concepts and did not 
see how they related to the real world. I can remember being out in the field dur-
ing my surveying class—looking through the survey instrument, writing down 
measurements, and having no idea why. That wasn’t an enjoyable feeling, and it 
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isn’t one I want you to experience as you learn the new and foreign concepts in 
this book. Eventually I learned all about surveying, and now I have an in-depth 
understanding of how those measurements relate to designing and building 
roads, buildings, and other things—but it took many years. It’s my sincerest 
hope that this book gives you a head start on some of those types of concepts 
while at the same time relating them to Civil 3D in ways that hit home for you.

What’s New in This Book?
If you already own AutoCAD Civil 3D 2015 Essentials, you’ll be happy to know 
that AutoCAD Civil 3D 2016 Essentials has been updated to address important 
changes in AutoCAD Civil 3D 2016. All applicable images have been updated 
in this version of the book to account for changes to the user interface and 
changes to functionality.  The dataset files have also been updated to ensure 
compatibility with AutoCAD Civil 3D 2016.

Who Should Read This Book?
This book should be read by anyone who needs or wants to begin learning 
AutoCAD Civil 3D. It’s appropriate for ages ranging from high school to retire-
ment, and although it’s intended for those who have no experience or skill with 
Civil 3D, it can also serve as a great resource for refreshing your knowledge base 
or filling in any gaps. In addition, this book can be used as a resource for  
preparing to take the AutoCAD Civil 3D 2016 Certified Professional exam. See 
www.autodesk.com/certification for more certification information and 
resources. You can also refer to this book’s appendix to see which certification 
topics are covered and where they can be found in the book. 

In addition to those pursuing a certification, here are some specific examples 
of individuals who would benefit from reading this book:

▶▶ High-school students following a design-related educational track

▶▶ College students learning to be designers or engineers

▶▶ Employees who have recently joined a company that utilizes Civil 3D

▶▶ Employees who work for companies that have recently implemented 
Civil 3D

▶▶ Experienced Civil 3D users who are self-taught and who want to fill 
in gaps in their knowledge base

http://www.autodesk.com/certification
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What You Will Learn
This book covers the basic skills and concepts needed to begin using Civil 3D to 
design land development projects. The concepts include those related to Civil 3D 
as well as those related to civil engineering and surveying in general. It doesn’t 
cover all topics or all Civil 3D features, but it provides a solid foundation you 
can use to perform basic tasks. This foundation can then serve as a stepping-off 
point as you learn more advanced skills and work toward an in-depth under-
standing of Civil 3D.

The first two chapters will give you a basic understanding of Civil 3D and help 
you to understand and appreciate how it “thinks.” The remaining 16 chapters 
will teach you how to use the tools that Civil 3D provides to complete a typical 
land development design project.

What You Need
Specific hardware requirements for running AutoCAD Civil 3D 2016 had  
not been released as this book went to press. See the Autodesk website  
(www.autodesk.com) for current requirements.

To perform the exercises in this book, you must have AutoCAD Civil 3D 2016 
installed on your computer. It’s recommended that you use the default software 
setup with two exceptions: Change your drawing screen color to white, and dock 
the command line at the bottom of the screen. This book contains many screen 
captures of Civil 3D drawings, which were all produced with these distinctive 
changes to the user interface. Also, at times, the exercises refer to drawing enti-
ties by color, which is sometimes dependent on the background color.

To complete the exercises, you’ll need to download the necessary files from 
www.sybex.com/go/civil3d2016essentials. Here you’ll find a list of Zip files, 
one for each chapter. When you unzip the file for the first chapter to the local C: 
drive of your computer, a folder named Civil 3D 2016 Essentials will be cre-
ated with the chapter folder inside it. As you unzip additional chapter files to the 
local simply merge the new Civil 3D 2016 Essentials folder into the old one. 
The resulting files and folders will appear similar to the following image:

http://www.autodesk.com
http://www.sybex.com/go/civil3d2016essentials
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Zip files are available in imperial and metric units. As you complete the exer-
cises, metric values will be shown in parentheses. The imperial and metric 
values for a given item usually are not equivalent, to avoid using irregular val-
ues for the design. For example, the value for the width of a sidewalk would be 
shown as 3’ (1m) even though 3’ doesn’t exactly equal 1m.

Finally, be sure to check the book’s website for any updates to this 
book should the need arise. You can also contact me directly by email at 
CivilEssentials@gmail.com or visit my blog at http://ericchappell 
.blogspot.com to read even more about the book and Civil 3D in general.

Free Autodesk Software for Students and Educators

The Autodesk Education Community is an online resource with more than 5 million 
members that enables educators and students to download—for free (see the 
website for terms and conditions)—the same software used by professionals 
worldwide. You can also access additional tools and materials to help you design, 
visualize, and simulate ideas. Connect with other learners to stay current with 
the latest industry trends and get the most out of your designs. Get started today 
at www.autodesk.com/joinedu.

mailto:CivilEssentials@gmail.com
http://ericchappell
http://www.autodesk.com/joinedu
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Attention: Instructors
As you know, the best classes start with good preparation, and you can get off to 
a good start by downloading the instructor materials that accompany this book. 
Please visit www.sybex.com/go/civil3d2016essentials to access the instructor 
materials, which contain suggested syllabi, PowerPoint files, additional exer-
cises, and quiz questions that you can use to assist you in making your class a 
success. 

What Is Covered in This Book?
AutoCAD Civil 3D 2016 Essentials is organized to provide you with the knowl-
edge needed to master the basics of AutoCAD Civil 3D 2016:

Chapter 1: Navigating the User Interface    Familiarizes you with the Civil 
3D environment so that you can navigate more easily in the software.

Chapter 2: Leveraging a Dynamic Environment    Demonstrates the dynamic 
Civil 3D environment to establish its importance and encourage you to take full 
advantage of it whenever possible. This chapter focuses on important relation-
ships between different components of a typical design model.

Chapter 3: Establishing Existing Conditions Using Survey Data     
Demonstrates how to convert survey field measurements into a Civil 3D drawing 
while focusing on the survey functions of Civil 3D. This chapter covers creating 
a survey database, importing data, and processing the data to create a map of 
the project.

Chapter 4: Modeling the Existing Terrain Using Surfaces    Demonstrates how 
to create a model of the existing terrain of the project while focusing on the sur-
face functions of Civil 3D. This chapter covers creating a new surface and adding 
data to it to form a 3D model of the before-construction condition of the project.

Chapter 5: Designing in 2D Using Alignments    Demonstrates how to per-
form basic 2D layout while focusing on the alignment functions of Civil 3D. 
This chapter covers creating alignments, applying design criteria, and editing 
alignments.

Chapter 6: Displaying and Annotating Alignments    Demonstrates how to 
control the appearance of alignments and provide annotation while focusing 
on Civil 3D alignment styles and alignment labels. This chapter covers applying 
alignment styles, creating alignment labels, and creating alignment tables.

http://www.sybex.com/go/civil3d2016essentials
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Chapter 7: Designing Vertically Using Profiles    Demonstrates how to design 
the vertical aspect of a linear feature while focusing on the profile functions of 
Civil 3D. This chapter covers creating profiles, applying design criteria, editing 
profiles, and displaying profiles in profile views.

Chapter 8: Displaying and Annotating Profiles    Demonstrates how to con-
trol the appearance of profiles and provide annotation while focusing on Civil 
3D profile styles and profile labels. This chapter covers applying profile styles, 
creating profile labels, and object projection.

Chapter 9: Designing in 3D Using Corridors    Demonstrates how to design 
a 3D model of a linear feature while focusing on the corridor functions of Civil 
3D. This chapter covers creating assemblies, creating and editing corridors, and 
creating corridor surfaces.

Chapter 10: Creating Cross Sections of the Design    Demonstrates how to 
generate and display cross sections of your design while focusing on the sample 
line and section functions of Civil 3D. This chapter covers creating sample lines, 
sampling various sources, and creating section views.

Chapter 11: Displaying and Annotating Sections    Demonstrates how to 
control the appearance of sections and provide annotation while focusing on 
Civil 3D section styles and section labels. This chapter covers applying section 
styles, creating section labels, and object projection.

Chapter 12: Designing and Analyzing Boundaries Using Parcels     
Demonstrates how to design a lot layout for a residential land development proj-
ect while focusing on the parcel functions of Civil 3D. This chapter covers creat-
ing and editing parcels.

Chapter 13: Displaying and Annotating Parcels    Demonstrates how to con-
trol the appearance of parcels and provide annotation while focusing on Civil 3D 
parcel styles and parcel labels. This chapter covers applying parcel styles, creat-
ing parcel labels, and creating parcel tables.

Chapter 14: Designing Gravity Pipe Networks    Demonstrates how to design 
underground gravity pipe systems for a residential land development project 
while focusing on the pipe network functions of Civil 3D. This chapter covers 
creating and editing pipe networks.

Chapter 15: Designing Pressure Pipe Networks    Demonstrates how to 
design underground pressure pipe systems for a residential land development 
project while focusing on the pressure pipe network functions of Civil 3D. This 
chapter covers creating and editing pressure pipe networks.
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Chapter 16: Displaying and Annotating Pipe Networks    Demonstrates how 
to control the appearance of pipe networks (both gravity and pressure) and pro-
vide annotation while focusing on Civil 3D pipe styles, structure styles, fitting 
styles, appurtenance styles, and pipe network labels. This chapter covers display-
ing pipe networks in profile view, creating pipe network labels, and creating pipe 
network tables.

Chapter 17: Designing New Terrain    Demonstrates how to design a proposed 
ground model for a residential land development project while focusing on the 
feature-line and grading functions of Civil 3D. This chapter covers creating and 
editing feature lines and grading objects.

Chapter 18: Analyzing, Displaying, and Annotating Surfaces    Demonstrates 
how to perform surface analysis and display the results as well as annotate design 
surfaces. This chapter covers managing multiple surfaces, labeling surfaces, and 
analyzing surfaces.

Appendix: AutoCAD Civil 3D 2016 Certification    Provides information 
about AutoCAD Civil 3D certification as well as how this book will help you to 
prepare for the certification exams. This appendix includes specific certification 
objectives along with where related material appears in the book. 

The Essentials Series
The Essentials series from Sybex provides outstanding instruction for readers 
who are just beginning to develop their professional skills. Every Essentials book 
includes these features:

▶▶ Skill-based instruction with chapters organized around projects 
rather than abstract concepts or subjects.

▶▶ Downloadable tutorial files showing the start and end state of each 
exercise.

▶▶ Digital extras so you can work through the project tutorials  
yourself. Please check the book’s web page at www.sybex.com/go/ 
civil3d2016essentials for these companion downloads.

The certification margin icon will alert you to sections that are especially rel-
evant to AutoCAD Civil 3D 2016 certification. See the appendix for a quick snap-
shot of the certification objectives covered in the book. 

The Autodesk certification exam objectives listed in the appendix were accu-
rate at press time; to find the latest information about the exam and what is 
covered, go to www.autodesk.com/certification. 

Certification
Objective

http://www.sybex.com/go/
http://www.autodesk.com/certification


Chapter 1

Navigating the  
User Interface
If you’re new to the AutoCAD® Civil 3D® software environment, then 
your first experience has probably been a lot like staring at the instrument 
panel of an airplane. Civil 3D can be quite intimidating, with lots of buttons, 
strange shapes, and unusual icons—all packed into a relatively small area. In 
addition, you may be even more intimidated by the feeling that there is a lot 
of power under the hood.

This leads us to our main objective for this chapter, which is to alleviate 
that feeling of intimidation and make you feel much more at ease within the 
Civil 3D environment. Let me start you down that path by saying that there’s 
a big difference between an airplane and Civil 3D. In Civil 3D, if you really 
mess up, you can simply close the drawing file without saving. When piloting 
an airplane, it’s a little more difficult to undo your mistakes.

After completing this chapter, you will have achieved a greater comfort 
level within the Civil 3D environment by being able to identify the main user 
interface components and utilize them for basic functions. You will also be 
able to use two specific features that will serve you well throughout the pro-
gram: the Transparent Commands toolbar and the Inquiry Tool.

In this chapter, you’ll learn to:

▶▶ Navigate the Civil 3D user interface

▶▶ Launch general commands through the application menu

▶▶ Launch key software commands and functions using the ribbon

▶▶ Navigate the design contents using the Toolspace

▶▶ Navigate the model using the drawing area

▶▶ Communicate with Civil 3D using the command line

▶▶ Access and modify design information using Panorama
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▶▶ Access specialized commands using the Transparent Commands toolbar

▶▶ Get information about your design using the Inquiry Tool

Getting to Know the Civil 3D User Interface
To begin learning about the Civil 3D environment, let’s take our airplane anal-
ogy down a notch and think about this as learning to drive an automobile. When 
your parents first sat you down at the wheel and talked about the car’s controls, 
they probably didn’t mention the air conditioning or the radio. Those, of course, 
are important parts of the driving experience, but I’m betting they started with 
the most important parts, such as the steering wheel, the gas pedal, and, most 
important of all, the brake pedal. We’re going to approach your first experience 
with “driving” Civil 3D in much the same manner.

There are many, many parts to the Civil 3D user interface. For the purpose of this 
book, I’ll cover just the ones that will be most important in enabling you to navigate 
the software effectively. Figure 1.1 shows the major components of the user interface.

Inquiry ToolRibbon

Transparent 
Commands 
Toolbar

Application 
Menu

Command 
Line

Toolspace Drawing 
Area

Panorama

F i g u re    1 . 1    Major components of the Civil 3D user interface

Certification
Objective
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Application Menu    The place where you can find everyday file-handling com-
mands that enable you to do things like open, save, and print your drawings

Ribbon    The place where most Civil 3D commands are launched

Toolspace    The Civil 3D “command center” where all the data and settings are 
laid out in an organized fashion

Drawing Area    The place where the drawing is created

Command Line    The “chat window” where you and Civil 3D talk to one another

Panorama    A multipurpose window where you can view and/or edit drawing 
information and properties

Inquiry Tool    A tool with many smaller tools within it that enable you to get 
information about your design

Transparent Commands Toolbar    A toolbar with special commands that 
allow drafting and geometric construction to be done in the way that civil engi-
neers and surveyors do it

Working with the Application Menu
The application menu (see Figure 1.2) expands out from the square AutoCAD 
Civil 3D icon located at the top left of your screen. Here, you’ll find commands 
for creating, opening, saving, and printing your drawing files.

F i g u re    1 . 2    Part of the Civil 3D application menu

◀

The Quick Access 
Toolbar just to the right 
of the AutoCAD Civil 3D 
icon is a handy subset 
of your most commonly 
used general-purpose 
tools. It can be custom-
ized to add more tools 
if you like.



4 	 C h ap t e r  1  •  N a v i g a t i n g  t h e  U s e r  I n t e r f a c e 

Exercise 1.1: Use the Application Menu to  
Open a File
In this exercise, you will use the application menu to open a file.

	 1.	 Launch Civil 3D by double-clicking the Civil 3D 2016 Imperial 
(Metric) icon on the desktop of your computer.

	 2.	 Click the application menu icon.

	 3.	 On the application menu, click Open.

	 4.	 Browse to the Chapter 01 class data folder, and open User Interface.dwg.

	 5.	 Open the application menu once more, and investigate the commands 
that are listed there. You’ll notice that most of them have to do with 
creating, opening, saving, and printing drawing files.

	 6.	 Keep this drawing open for the next exercise.

Because nothing changes in this drawing file as a result of the exercise steps, 
no User Interface – Complete file is necessary. 

It’s All in How You Look at It

This drawing, like many other drawings you’ll open while working through this 
book, is set up with three viewports. The one on the left is top-down, or plan 
view, showing the entire project. The one at the top right is also plan view, but 
it is zoomed in to a different part of the drawing. The lower-right viewport is a 
3D view. These are three views of the same design, and what happens in one will 
happen in the other two. Think of it as three cameras showing three different 
viewpoints of the same subject, with each viewport being like a television monitor.

▶

If you haven’t already 
done so, download 
and install the files for 
Chapter 1 according to 
the instructions in this 
book’s Introduction. 
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Working with the Ribbon
The ribbon is located at the top of your screen, and it is the launching pad 
for most of your Civil 3D commands. The commands that it contains are 
organized into groups through the use of tabs and panels. The ribbon itself is 
divided into a series of tabs that include Home, Insert, Annotate, and so on, as 
illustrated in Figure 1.3.

F i g u re    1 . 3    Tabs arrange large numbers of similar Civil 3D commands into groups.

Each tab is divided into panels. For instance, the Home tab shown in 
Figure 1.4 includes the Palettes, Create Ground Data, Create Design, Profile & 
Section Views, and Draw panels.

F i g u re    1 . 4    Panels provide another level of grouping within a ribbon tab.

Because Civil 3D groups the commands in this way, you never have to choose 
from more than a handful of commands once you’ve taken your best guess at 
the correct tab and panel. Also, you’ll find that the more you use Civil 3D, the 
better you will get at knowing the location of the commands. It’s not so much 
memorizing their positions as it is learning how Civil 3D “thinks”—that is, the 
way in which it relates commands to one another and categorizes them into 
tabs and panels.

One other thing you should know is that most panels expand downward to 
show you the less frequently used commands in a particular category. You’ll 
know that a panel expands when you see a downward-pointing white triangle 
next to its name. For example, Figure 1.5 shows the Home tab’s Create Design 
panel expanded with more commands. Don’t forget to look on these hidden pan-
els when searching for commands.



6 	 C h ap t e r  1  •  N a v i g a t i n g  t h e  U s e r  I n t e r f a c e 

F i g u re    1 . 5    Most panels expand downward to reveal more commands, as is the case with the 
Create Design panel on the Home tab of the ribbon.

One of the best features of the ribbon is its ability to respond to what you 
select in the drawing area. For example, if you click a Civil 3D alignment, the 
ribbon changes and serves up alignment-related commands on a special tab. 
The same is true for surfaces, parcels, and so on. These special tabs are referred 
to as contextual ribbon tabs. They are a huge help when you’re first learning 
Civil 3D and a huge time-saver even after you’ve become a master.

Another Great Way to Find Commands

Sometimes you really have no idea where to even begin looking for a com-
mand. The application menu has a handy tool that will help you find just about 
any command, regardless of where it is in the user interface. Simply click the 
application menu and type a keyword in the search bar. You’ll be given a list of 
commands that match your keyword. You can launch a command right from the 
list by clicking it, or you can learn where the command is located by looking at 
the information shown to the right of it.
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Exercise 1.2: Use the Ribbon to Launch 
Commands
In this exercise, you will familiarize yourself with the ribbon’s tabs and panels.

	 1.	 Launch Civil 3D 2016, and open the file named User Interface.dwg.

	 2.	 Click the Home tab of the ribbon to bring it to the forefront (it may 
be there already).

	 3.	 Click the downward-pointing white triangle at the bottom of the 
Create Design panel and note how it expands down, as shown previ-
ously in Figure 1.5.

	 4.	 Click the Insert tab of the ribbon. Here, you see words like insert, 
import, and attach, which are all ways of bringing information into 
the drawing.

	 5.	 Click the other tabs of the ribbon, and see whether you can relate 
some of the words you see in the commands to the title of each rib-
bon tab.

	 6.	 Place your cursor in the left viewport, and roll the mouse wheel 
forward to zoom in to the drawing. Keep zooming in until you can 
clearly see the road centerlines labeled with stationing numbers 
(these are Civil 3D alignments). Click one of the road centerlines, and 
note that the ribbon displays a contextual tab to make alignment 
commands accessible (see Figure 1.6).

F i g u re    1 . 6    The ribbon displays the contextual Alignment: Main Road A tab because an 
alignment has been selected in the drawing (the name of the tab you see may be slightly different 
depending on which alignment you selected).

◀

If you are continuing 
from the previous 
exercise, you can skip 
to step 2. If you don’t 
have the necessary 
file(s), download and 
install the files for 
Chapter 1 according to 
the instructions in this 
book’s Introduction.
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	 7.	 Keep this drawing open for the next exercise.

Because nothing changes in this drawing file as a result of the exercise steps, 
no User Interface – Complete file is necessary.

Working with the Toolspace
Think of the Toolspace as the Civil 3D “command center” where all Civil 3D 
data and settings are laid out in a nice, orderly arrangement. It has several main 
functions that are represented by the different tabs it can contain. Altogether, 
the Toolspace can house four tabs: Prospector, Settings, Survey, and Toolbox.

Prospector Tab
Prospector is arguably the most important part of the Civil 3D user interface. 
As you build your design, Prospector arranges the different components of your 
design in a tree structure (see Figure 1.7). Why a tree structure and not just a 
list of items? Later in this book, you’ll study how Civil 3D creates relationships 
between different parts of your design. In some ways, this tree structure helps 
represent some of those relationships as a hierarchy. Another, more practical 
reason for a tree structure is that it’s an efficient way to show a long list of items 
in a relatively small area—the branches of the tree can be collapsed to make 
room to expand other branches.

F i g u re    1 . 7    The Prospector tab showing a portion of the tree structure

▶

You can open the 
Toolspace by clicking 
the Toolspace icon on 
the Home tab of the 
ribbon.

Certification
Objective
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Another way to think about Prospector is that it arranges your design cat-
egorically rather than spatially. In other words, in your drawing area, you might 
see road centerlines crossing through parcels, which cross through contours, 
which cross through survey points. Everything is in the right place spatially, but 
from an organizational standpoint, it’s kind of a mess. Prospector sorts out this 
mess and puts all the points in one place, all the parcels in one place, and so 
on. Prospector also knows exactly where those objects are in the drawing. You 
can right-click an object in Prospector and use the Select command or Zoom To 
command to locate that object within the drawing.

Exercise 1.3: Explore the Model with the 
Prospector Tab
In this exercise you will use the Prospector tab of the Toolspace to explore  
the model.

	 1.	 Launch Civil 3D 2016, and open the file named User Interface.dwg.

	 2.	 If the Toolspace is not already open, click Toolspace on the Home tab 
of the ribbon.

	 3.	 Click the Prospector tab of the Toolspace to bring it to the forefront.

	 4.	 Explore the tree structure of Prospector by clicking the plus signs to 
expand the different branches.

	 5.	 Expand Alignments ➢ Centerline Alignments ➢ Main Road A ➢ 
Profiles. This hierarchical arrangement provides effective organi-
zation and suggests a relationship between the alignment and its 
profiles.

	 6.	 Click within the left viewport to activate it. Then, on the 
Prospector tab, right-click Side Road B, and select Zoom To. 
Notice how Prospector knows the location of the alignment 
named Side Road B, even if you don’t.

	 7.	 Keep this drawing open for the next exercise.

Because nothing changes in this drawing file as a result of the exercise steps, 
no User Interface – Complete file is necessary.

It’s important to point out that Prospector isn’t just a place for viewing your 
design; it’s also a place where you can change the appearance of your design, 

If you are continuing 
from the previous 
exercise, you can skip 
to step 2. If you don’t 
have the necessary 
file(s), download and 
install the files for 
Chapter 1 according to 
the instructions in this 
book’s Introduction.

◀

◀

If the Prospector tab 
is not visible, click the 
Home tab of the rib-
bon and then click the 
Prospector icon on the 
Palettes panel.
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create new components for your design, edit your design, and so on. These types 
of functions are accessed through contextual menus such as the one used in 
step 6 of Exercise 1.3. A good rule of thumb when using Prospector is, “When in 
doubt, right-click it.”

Settings Tab
Civil 3D has a lot of settings that control nearly every aspect of how the software 
behaves. In fact, one of the things that makes Civil 3D so powerful is that you 
can customize its settings to accommodate nearly any type of design, any com-
pany standard, or any other factor that defines the environment within which 
you use it. The Settings tab is where these settings are managed; however, you 
won’t be spending much time here in the early part of your Civil 3D career. This 
area is more often the territory of a CAD manager or Civil 3D guru.

Exercise 1.4: Explore the Drawing Settings with 
the Settings Tab
In this exercise, you will use the Settings tab of the Toolspace to explore the 
drawing settings.

	 1.	 Launch Civil 3D 2016, and open the file named User Interface.dwg.

	 2.	 If the Toolspace is not already open, click Toolspace on the Home tab 
of the ribbon.

	 3.	 Click the Settings tab of the Toolspace.

	 4.	 Expand Surface ➢ Surface Styles, and note the list of styles shown 
there. These styles control the appearance of models that represent 
the shape of the ground.

	 5.	 Expand Surface ➢ Label Styles ➢ Contour, and note the list of styles 
shown there. These styles control a certain type of label that is used 
to annotate surface models.

	 6.	 Keep this drawing open for the next exercise.

Because nothing changes in this drawing file as a result of the exercise steps, 
no User Interface – Complete file is necessary.

Certification
Objective

If you are continuing 
from the previous 
exercise, you can skip 
to step 2. If you don’t 
have the necessary 
file(s), download and 
install the files for 
Chapter 1 according to 
the instructions in this 
book’s Introduction.

▶

▶

If the Settings tab is 
not visible, click the 
Home tab of the rib-
bon and then click the 
Settings icon on the 
Palettes panel.


